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Setting and password-protecting closed periods 
 
As mentioned in the introduction to this chapter, with QuickBooks there is no need to 
run any complicated year-end book-closing routines. You can, at any time, enter 
transactions dated in the future financial year, and you can also alter and record 
transactions for any prior financial year that has not yet been finalised. 
 
Of course, if all accounts are reconciled and if year-end statements and income taxes 
were prepared and filed for a given financial year, then it’s prudent to ensure that no 
further transactions are recorded for this “closed period”. 
 
You can close such a period by setting the Closing Date preference.  
 

1. From the Menu bar, click on Edit, Preferences, select Accounting and click on 
Company Preferences. 

 

 
 

2. Notice that QuickBooks has already set a closing date, based on the last VAT 
return you filed (1). 

 
3. Click the Set Date/Password button (2), and in the “Set Closing Date and 

Password window”, change the date (3), and add a password (4). 
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Implications of not having a closing date password 
 
The closing date password, which is distinct from the user passwords, introduces an 
additional element of security. If you don’t set a closing date password and try to post 
a transaction in a closed period, QuickBooks displays the “soft” warning shown below 
(5).  
 

 
 
If you clicked Yes, QuickBooks would then record the transaction.  
 
As can sometimes happen, it’s quite easy for someone who’s slightly inattentive or 
pressed for time to misread the warning and click Yes, thereby recording a transaction 
that leads to incorrect financial information.  
 
By creating a password QuickBooks will open a window requesting that the password 
is entered before it will allow you to make a correction (6). 
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Backing up your company file 
 
The most crucial thing you can do to prevent data loss is back up your company file. 
Remember that because QuickBooks tracks all of your financial years in one file, a 
failed computer could result in your losing all of your company’s financial information. 
You should back up your data at the end of each session or each day. It is wise to 
keep backups on an external drive or storage device rather than on your hard disk – if 
you back up onto your hard disk and then your computer has problems you’d lose the 
backup as well.  
 
In the Basic Course you learned how to do a full backup (to QBB format) and a 
portable file backup (to QBM format). In this chapter we’ll see the two ways in which 
you can schedule full backups. 
 
 
Automatically back up the data file when closing QuickBooks  
 
With this method, QuickBooks automatically saves the backup to the program folder 
on your computer’s hard drive either every time or some of the times that you close 
your company file or exit QuickBooks. You choose the frequency. 
 

1. From the File menu, choose the Save Copy or Backup… option. 
 

2. Select Backup Copy and click Next. 
 

3. Click Options (1) to let QuickBooks know your default backup settings.  
 

 
 

Choose a backup location (2), add a date and time stamp to the backup (3), 
and limit the number of backup copies to this location (4). You can also ask 
QuickBooks to remind you to back up (5). It’s highly recommended that you do 
a complete verification every time you backup (6).  

1



  161 

 
 
Click OK to return to the Save Copy or Backup window, then click Next.. 
 

4. QuickBooks asks you when you want to save your backup. Choose one of the 
options.  
 
• Save Now – choosing this means you just save this one backup. Click 

Finish to start the back up. 
• Save now and schedule for future backups – asks you to set up a backup 

schedule and then backs up your file.  
• Only schedule future backups – asks you to set up a backup schedule but 

does not back up the file at this time. 
 

 
 
Let’s choose the last option, “Only Schedule future backups” (7). 
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5. In the Choose Backup automatically area, tick the box “Save backup copy 
automatically when I close my company file every….times”, and enter the 
number of times QuickBooks closes before it takes a backup copy (8). This 
backs up automatically every 3rd time you close the file, if ‘3’ times is chosen. 
 
Notice that you can change the backup options you defined earlier, or view 
them, by clicking the Options button. 

 

 
 
Note: since the backup is made to your hard drive, if your computer crashes 
you will lose the back up data as well.  

 
 
Schedule automated and unattended backups  
 
With this method, QuickBooks automatically saves the backup at a scheduled time to 
the program folder on your computer’s hard drive or onto an external backup device. 
For the backup to be made, your computer must be running and your company data 
file closed. 
 

1. Follow the steps 1 -4 above. On step five, click the New button (1), to create a 
new schedule.  

 

 
2. In the fields of the Schedule a Backup window which appears:   
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• Enter a description (name) for your scheduled backup (2). 
• Specify a location. You can specify a remote location (another 

computer on a network) or use a removable storage medium (CD, 
USB, etc.) Use Browse to find an existing location or type in the path 
(3). 

• (Optional) If you want to keep more than one backup, select Number 
of backups to keep and specify how many (4). 

• Select the time and day you want the backup to run (5). 
• If necessary, enter your Windows log-in password by using Store 

password (6).  
 

 
 

3. Click OK. QuickBooks adds the backup to the scheduled backup list (7). 
 

 
 
 
Restoring your company file 
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Not all situations where you must restore a company file are emergencies! Maybe you 
purchased a new computer, or replaced the hard drive on your current computer. But 
there is the occasional catastrophic equipment failure or case of driver error which 
results in a damaged or lost company file. If you have used one or more of the backup 
methods above, you need not panic. You can easily restore your QuickBooks data file 
from a backup copy. 
 
As the QuickBooks backup file is a special compressed copy of your company file, you 
must use the Restore command from the File menu to bring data back into 
QuickBooks from a backup file.  
 
How to restore your company file from a full backup 
 
This section deals with restoring a file from a manual or scheduled backup file.  
 

1. Place storage medium on which you have saved the backup company file (CD, 
floppy, USB memory key, etc.) into your computer’s drive. 
 

2. From the File menu, choose Open or Restore Company. 
 

3. In the Open or Restore window, select Restore a backup copy (1) 
 

 
 

4. QuickBooks now prompts you to navigate to the location where your backup 
file resides. Highlight the file, and click Open.  
 

 
 

5. You are returned to the Open or Restore Company window, which now informs 
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you that you are about to choose the location where you want to restore the 
file (not shown). 

 
6. Browse to the location on your computer where you wish to restore the file. 

 

 
 

7. Click Save. QuickBooks will restore the company file to the chosen location 
and you can now work with the restored file normally after verifying it (see next 
section). If a copy of the file already exists, you will be prompted twice to 
overwrite it – the first time you are asked if  you are sure, the second time you 
have type in “yes” to confirm.  

 
Note: in the process of restoring your file, you are deleting your existing 
company file and replacing it with the restored version. 
 
Note: Remember, in the case of a file damaged or lost, you will have to 
re-enter any transactions you entered into your company data file after you 
backed it up and before you suffered the file loss. 

 
 
 
Verifying your company file 
 
The Verify Data utility detects and reports any data errors in your company file.  
 
If you have restored your company file, you should always verify your data file to 
ensure its integrity.  
 

1. To start the verification process, click on File, choose Utilities, then select 
Verify Data. 

 
 

2. QuickBooks will display the Verify Data window advising that all open 
QuickBooks windows will be closed. Click OK. 
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3. QuickBooks will then, most probably, display the following message, 
indicating that no errors were found in your company file. 

 

 
 
You can also use this utility to verify your company file, to satisfy yourself that the file 
has not developed any data errors. It is advisable to run the utility from time to time, 
especially if you are using scheduled backups. 
 
You can verify and back up your file at the same time. In the Backup Options (above) 
two of the choices are to have Complete Verfication (recommended) or Quicker 
Verification.  
 
While the Complete Verification option takes a little more time, it is strongly advised 
that you use it regularly to ensure the ongoing integrity of your company file. 
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Rebuilding a damaged company file 
 
Should QuickBooks report data errors, the Rebuild utility can usually correct those 
errors. 
 

1. Click on File, Utilities then Rebuild Data. QuickBooks will display the 
Rebuild Data window advising that all open QuickBooks windows will be 
closed. Click OK. 

 

 
 

2. QuickBooks will then ask you to approve the making of a backup of your 
company file. Once more click OK. 

 

 
 

3. Choose the Filename and lcoation of the backup, then click OK. 
 

 
 

4. QuickBooks backs up the file and proceeds with the data rebuild. Finally, 
QuickBooks advises that the rebuild process has been completed. Click 
OK to close the window. 
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5. Verify your file once again to check that the errors have been fixed. If they 
have, you may work with your company file as usual. If it has not, please 
contact Intuit for further help. 

 
 
 
Chapter summary 
 
This chapter introduced important housekeeping tasks which protect the integrity of 
your data file. You now know how to: 
 

• Set a closing date and password to prevent accidental entries to closed 
periods. 

• Back up your company file using a schedule. 
• Restore your company file from a backup if necessary. 
• Verify your company file. 
• Rebuild a damaged company file if necessary. 
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 QuickBooks Learning Centre 
 
The QuickBooks Learning Center is a good place to find out more information about 
how QuickBooks works. 
 
To access the Learning Centre: 
 

1. From the Menu bar, click on Help. 
 

2. Then select Learning Centre. 
 

3. Click the topics on the left side of the screen to learn more about that topic. 
 

 
 
 



  171 

Using Help 
 
At times you will need to refer to the QuickBooks Help to learn more about a feature 
or check that you are doing things correctly.  
 
To access Help within QuickBooks: 
 

1. From the Menu bar, click on Help. 
 

2. Then select QuickBooks Help (you can also press the F1 key to bring up Help). 
 

3. The Help has two tabs – an Index tab (1) and a Search tab (2). Click on the 
Search tab.  
 
On the left side, enter your search word or phrase (3) and then press Ask., 
The search results are displayed below (4).  
 
Click on a results topic to display the Help documentation in the right pane 
(5).  
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 QuickBooks 2008 Support Centre 
 
You can access the Support Resources in QuickBooks 2008, from the Help Menu 
(click Help in the Menu Bar). Select Contact Support.  
 

 
 

From here you can access various support options: 
 

• The Knowledgebase 
 
• The Online Community 

 
• Free Support through Intuit (within 30 days of Product Registration) 

 
• Paid Support through Intuit Support Plans and Professional Advisors  

 
• QuickBooks Training 
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Online Support and Resources  
 
The same support options can also be found online at www.quickbooks.co.uk. Click 
the Support link (1) then choose one of the options in the drop down menu (2) 
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QuickBooks Online Community and Knowledge Base  
 
Another useful tool is the Online Community and Knowledge Base. You can reach this 
from the Support Centre within QuickBooks 2008…. 
 

 
 
… or online. 
 

 
 
It’s a great place to get answers on QuickBooks specific (1) or even general business 
(2) questions from fellow users and from Professional Advisors. Intuit moderates this 
site and if an answer is not provided within 2 weeks of posting, they will post a reply.  
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